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ABSTRAK 
Penyediaan air bersih merupakan kebutuhan dasar masyarakat yang harus terpenuhi secara 

berkelanjutan. Dusun Laba Desa Rosoan Kabupaten Enrekang mengalami peningkatan jumlah 

penduduk yang berdampak pada meningkatnya kebutuhan air bersih, sementara ketersediaan air 

masih terbatas terutama pada musim kemarau. Penelitian ini bertujuan untuk menghitung 

kebutuhan air bersih hingga tahun 2030 serta merencanakan sistem penyediaan air bersih yang 

optimal. Metode penelitian yang digunakan adalah metode kuantitatif dengan pengumpulan data 

primer dan sekunder. Proyeksi jumlah penduduk dilakukan menggunakan metode regresi linear 

(least square). Perhitungan kebutuhan air mengacu pada standar perencanaan air bersih pedesaan. 

Analisis jaringan distribusi dilakukan menggunakan perangkat lunak EPANET 2.0 dengan sistem 

aliran gravitasi. Hasil analisis menunjukkan bahwa jumlah penduduk pada tahun 2030 

diproyeksikan sebesar 318 jiwa dengan kebutuhan air bersih total sebesar 0,267 liter/detik yang 

meliputi kebutuhan domestik, non-domestik, dan kehilangan air. Sumber air berasal dari mata air 

dengan debit sebesar 4,8 liter/detik sehingga mampu memenuhi kebutuhan hingga tahun 

perencanaan. Sistem direncanakan menggunakan bangunan bronkaptering berukuran 2 m × 1,25 

m × 1,25 m, pipa transmisi HDPE diameter 2,5 inci, serta reservoir dengan kapasitas 41,039 m³. 

Hasil simulasi menunjukkan sistem distribusi memenuhi kriteria hidrolis yang dipersyaratkan. 

Kata Kunci: Air Bersih, Kebutuhan Air, Reservoir, EPANET 2.0, Sistem Gravitasi. 
 

ABSTRACT 

Clean water supply is a fundamental community need that must be fulfilled sustainably. Laba 

Hamlet, Rosoan Village, Enrekang Regency, is experiencing population growth which has led to 

an increase in clean water demand, while water availability remains limited, especially during the 

dry season. This study aims to calculate clean water demand until 2030 and to design an optimal 

clean water supply system. This research employed a quantitative method using both primary and 

secondary data. Population projection was carried out using the linear regression (least square) 

method. Water demand calculation referred to rural clean water planning standards. Distribution 

network analysis was performed using EPANET 2.0 software with a gravity flow system. The 

results show that the projected population in 2030 is 318 people with a total clean water demand 

of 0.267 liters per second, including domestic, non-domestic, and water loss components. The 

water source comes from a spring with a discharge of 4.8 liters per second, which is sufficient to 

meet the projected demand. The system was designed using a bronkaptering structure measuring 

2 m × 1.25 m × 1.25 m, a 2.5-inch HDPE transmission pipe, and a reservoir with a capacity of 

41.039 m³. Simulation results indicate that the distribution system meets the required hydraulic 

criteria. 

Keywords: Clean Water, Water Demand, Reservoir, EPANET 2.0, Gravity System. 

 

PENDAHULUAN 

Air bersih merupakan kebutuhan dasar yang berperan penting dalam menunjang 

kesehatan, kesejahteraan, dan produktivitas masyarakat. Ketersediaan air bersih yang 

memenuhi aspek kuantitas, kualitas, dan kontinuitas menjadi indikator penting dalam 

pembangunan wilayah, khususnya di daerah pedesaan. Seiring dengan pertumbuhan 

penduduk dan peningkatan aktivitas masyarakat, kebutuhan air bersih terus mengalami 

peningkatan sehingga diperlukan sistem penyediaan air yang direncanakan secara teknis 

dan berkelanjutan. 
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Dusun Laba, Desa Rosoan, Kabupaten Enrekang merupakan wilayah pedesaan yang 

mengalami pertumbuhan penduduk setiap tahunnya. Peningkatan jumlah penduduk 

berdampak langsung terhadap meningkatnya kebutuhan air bersih, baik untuk kebutuhan 

domestik maupun non-domestik. Pada kondisi eksisting, masyarakat masih memanfaatkan 

sumber mata air secara sederhana tanpa perencanaan sistem distribusi yang terstruktur. 

Kondisi ini menyebabkan pelayanan air bersih belum optimal, terutama pada musim 

kemarau ketika debit sumber air mengalami penurunan. 

Permasalahan lainnya adalah belum adanya analisis hidrolis yang memadai terkait 

kapasitas sumber air, proyeksi kebutuhan air jangka panjang, serta perencanaan jaringan 

transmisi dan distribusi. Tanpa perencanaan teknis yang tepat, sistem penyediaan air 

berpotensi mengalami ketidakseimbangan antara ketersediaan dan kebutuhan, sehingga 

mengganggu kontinuitas pelayanan kepada masyarakat. 

Oleh karena itu, diperlukan perencanaan sistem penyediaan air bersih yang 

mencakup proyeksi jumlah penduduk, perhitungan kebutuhan air hingga tahun rencana 

2030, analisis ketersediaan sumber air, serta perencanaan jaringan distribusi berdasarkan 

analisis hidrolis. Dengan perencanaan yang sistematis dan berbasis teknis, diharapkan 

sistem penyediaan air bersih di Dusun Laba dapat memenuhi kebutuhan masyarakat secara 

optimal dan berkelanjutan. 

 

METODOLOGI 

Penelitian ini menggunakan metode kuantitatif, yaitu penelitian ilmiah yang 

sistematis terhadap fenomena dan bagian-bagiannya, serta kualitas hubungan 

antarvariabel. Metode kuantitatif didefinisikan sebagai investigasi sistematis terhadap 

fenomena dengan mengumpulkan data yang dapat diukur, kemudian dianalisis 

menggunakan teknik statistik, matematika, atau komputasi. Dalam penelitian kuantitatif, 

data dikumpulkan untuk memperoleh informasi numerik yang dapat dianalisis secara 

objektif. Para peneliti menggunakan kerangka kerja matematika dan teori yang relevan 

untuk memahami kuantitas yang diamati, sehingga hasil penelitian bersifat terukur dan 

dapat digeneralisasikan sesuai tujuan studi. 

 

HASIL DAN PEMBAHASAN 

Hasil Penelitian 

Kondisi Eksisting 

Dusun Laba, Desa Rosoan merupakan wilayah yang berada di Kabupaten Enrekang. 

Dalam perencanaan sistem penyediaan air bersih, dilakukan observasi lapangan terhadap 

sumber mata air yang berjarak ±1,34 km dari Dusun Laba dengan elevasi ±4,79 m dan 

koordinat 3º29’35,33287’’S 119º49’1’’E. Hasil observasi menunjukkan bahwa mata air 

memiliki potensi air yang bersih, jernih, dan tidak tercemar sampah plastik, sehingga layak 

dimanfaatkan untuk memenuhi kebutuhan air bersih masyarakat sehari-hari.Berdasarkan 

pengukuran langsung di lokasi menggunakan current meter dan stopwatch, diperoleh debit 

rata-rata sebesar 4,8 liter/detik. Pengukuran dilakukan sebanyak lima kali untuk 

memperoleh nilai rata-rata yang representatif. Berdasarkan keterangan masyarakat Dusun 

Laba, mata air tersebut tidak pernah mengalami kekeringan sepanjang tahun. Selanjutnya, 

dilakukan observasi pada bagian hulu mata air untuk meninjau kondisi daerah imbuhan 

(recharge area) guna memastikan keberlanjutan ketersediaan air pada sumber tersebut..  
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Gambar 1. Skema Penempatan Kran Umum 

(Sumbeir: Google EarthPro, 2025) 

 

Tabeil 1. Jumlah penduduk 5 tahun terakhir. 

Tahuin y Tahuin Juimlah Peinduiduik (Y) 

1 2021 255 

2 2022 247 

3 2023 269 

4 2024 274 

5 2025 279 

(Suimbeir : Kantor Deisa Rosoan Kabuipatein Einreikang). 

 

Tabeil 2. Jumlah proyeksi  penduduk 5 tahun mendatang. 

X Thuin proyeiksi X Juimlah Peinduiduik (Y) 

6 2026 287 

7 2027 295 

8 2028 305 

9 2029 310 

10 2030 318 

(Suimbeir: Hasil peirhituingan). 

Analisis jumlah perhitungan kebutuhan air bersih  

A. Kebutuhan Air Domestik 

Kebutuhan air domestik adalah kebutuhan air bersih untuk keperluan rumah tangga 

seperti minum, memasak, mandi, mencuci, dan kegiatan sehari-hari lainnya. Sistem 

pelayanan air bersih di Dusun Laba direncanakan melalui keran umum sebagai titik 

distribusi ke masyarakat.Dalam penelitian ini, kebutuhan air domestik ditetapkan sebesar 

60 liter/orang/hari, mengacu pada Petunjuk Praktis Perencanaan Air Bersih Pedesaan 

(2008) yang menetapkan kisaran kebutuhan 30–60 liter/orang/hari. Standar yang 

digunakan adalah nilai maksimum untuk memastikan pelayanan yang optimal.Perhitungan 

kebutuhan air domestik didasarkan pada hasil proyeksi jumlah penduduk hingga tahun 

2030, dengan mengalikan jumlah penduduk hasil proyeksi dengan angka kebutuhan air per 

kapita (60 liter/orang/hari). Nilai ini kemudian digunakan sebagai dasar dalam 

perencanaan kapasitas sistem penyediaan air bersih di wilayah studi. 
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Tabel 3.Jumlah kebutuhan air domestik. 

  

Tahun X 

  

  

Jumlah penduduk  Y 

  

Kebutuhan air domestik (Liter/ Detik) 

Qd = (Yx(60 liter/org/hari)) / (24 x 

3600) 

2021 255 0,177 

2022 247 0,172 

2023 269 0,187 

2024 274 0,190 

2025 279 0,194 

2026 287 0,200 

2027 295 0,205 

2028 305 0,212 

2029 310 0,215 

2030 318 0,221 

(Suimbeir : Hasil peirhituingan). 

 

B. Kebutuhan Air Non Domestik 

Kebutuhan air non-domestik adalah kebutuhan air bersih untuk fasilitas pelayanan 

umum dan kegiatan komersial, seperti sarana pendidikan, tempat ibadah, fasilitas 

kesehatan, perkantoran, serta usaha kecil di wilayah desa. Dalam penelitian ini, 

perhitungan kebutuhan air non-domestik mengacu pada Standar Perencanaan Air Bersih 

Pedesaan (2008), yaitu sebesar 5% dari kebutuhan air domestik.  

Tabel 4. Perhitungan kebutuhan air non  domestik. 

Tahun 
Jumlah Penduduk (jiwa ) 

Y 

Kebutuhan air domestik (Liter/ 

Detik) Qd = (Y x(60 

liter/org/hari)) / (24 x 3600) 

 

Kebutuhan air non 

domestic (Liter/ 

Detik) Qn = Qd x 5 % 

2021 255 0,177 0,009 

2022 247 0,172 0,009 

2023 269 0,187 0,009 

2024 274 0,190 0,010 

2025 279 0,194 0,010 

2026 287 0,200 0,010 

2027 295 0,205 0,010 

2028 305 0,212 0,011 

2029 310 0,215 0,011 

2030 318 0,221 0,011 

(Sumber: Hasil perhitungan). 

C. Perhitungan Kehilangan Air 

Berdasarkan Standar Perencanaan Air Bersih Pedesaan tahun 2008, angka persentase 

kehilangan air untuk perencanaan sistem penyediaan air bersih pedesaan yaitu sebesar 15% 

dari kebutuhan rata-rata, di mana kebutuhan rata-rata adalah sejumlah kebutuhan domestik 

ditambah dengan kebutuhan non-domestik. 
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Tabel 5.Kehilangan air. 

 Tahun  X   Jumlah Penduduk (y) 
Kehilangan air (Liter/ Detik) Qa 

= ( Qd + Qn ) x 15% 

2021 255 0,0279 

2022 247 0,0270 

2023 269 0,0294 

2024 274 0,0300 

2025 279 0,0305 

2026 287 0,0314 

2027 295 0,0322 

2028 305 0,0334 

2029 310 0,0339 

2030 318 0,0348 

(Sumber: Hasil perhitungan). 

D. Kebutuhan Air Total 

Keibuituihan air total adalah total keibuituihan air baik domeistik, non domeistik 

ditambah keihilangan air 

Tabel 6 kebutuhan air total 

Tahun X 
jumlah penduduk 

(y) 

Kebutuhan Air Total (Liter/ 

Detik) Qt = Qd + Qn+ Qa 

2021 255 0,214 

2022 247 0,207 

2023 269 0,226 

2024 274 0,230 

2025 279 0,234 

2026 287,3 0,241 

2027 294,8 0,247 

2028 305 0,256 

2029 310 0,260 

2030 318 0,267 

(Suimbeir: Hasil peirhituingan 2026) 

E. Keibuituihan Air Harian Maksimuim dan keibuituihan air jam puincak. 

Keibuituihan air harian maksimuim dihituing beirdasarkan keibuituihan air total 

dikali faktor peingali yaitui 1,1. Keibuituihan air jam puincak adalah keibuituihan air pada 

jam-jam teirteintui dalam satui hari dimana keibuituihan airnya akan meimuincak. 

Keibuituihan air jam puincak dihituing beirdasarkan keibuituihan air total dikali faktor 

peingali yaitui 1,2. (Peituinjuik Praktis Peirein-canaan Peimbanguinan Sisteim 

Peinyeidiaan Air Beirsih Peideisaan, 2006). 

Tabel 7. Kebutuhan air harian maksimum. Dan kebutuhan air jam puncak. 

Tahun  
Jumlah Penduduk 

(jiwa ) Y 

Kebutuhan air harian 

maksimum (liter/detik) 

Qm+1,1 x Qt 

Kebutuhan air jam puncaak 

(liter/detik) Qp=1,5 x Qt 

2021 255 0,235 0,321 

2022 247 0,228 0,311 

2023 269 0,248 0,338 

2024 274 0,253 0,345 

2025 279 0,257 0,351 
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2026 287,3 0,265 0,361 

2027 294,8 0,272 0,371 

2028 305 0,281 0,384 

2029 310 0,286 0,390 

2030 318 0,294 0,400 

(Suimbeir : Hasil peirhituingan 2026 ). 

 

Sistem Plan Pengambilan Air Baku 

Berdasarkan hasil perhitungan, kebutuhan air total pada tahun 2030 sebesar 3,184 

liter/detik. Untuk memenuhi kebutuhan air bersih di Dusun Laba Desa Rosoan, dalam 

perencanaan sistem penyediaan air bersih digunakan mata air dengan debit 4,8 liter/detik. 

Mata air ini terletak pada jarak ± 1,34 km dari permukiman warga Dusun Laba Desa 

Rosoan. Karena debit tersedia lebih besar daripada kebutuhan air jam puncak, maka pada 

penelitian ini tidak digunakan Hidran Umum, melainkan digunakan Keran Umum untuk 

distribusi air ke Dusun Laba Desa Rosoan. Kawasan sekitar mata air belum terdapat 

kegiatan berupa pertanian maupun pengolahan lahan/kayu sehingga kelestariannya masih 

terjaga. Untuk layanan terjauh yang akan dialiri berada pada elevasi +462 m. Karena beda 

tinggi antara mata air dan desa lebih dari 100 m, maka diperlukan Bak Pelepas Tekan 

(BPT) untuk menghindari terjadinya kerusakan pada pipa akibat tekanan yang terlalu 

besar. Rencana sistem penyediaan air bersih di Dusun Laba Desa Rosoan yang bersumber 

dari mata air adalah sebagai berikut: 

1. Bronkaptering dari Mata Air 

Bronkaptering adalah bangunan konstruksi yang dibangun pada lokasi sumber 

air dan digunakan untuk menangkap serta mengambil air guna penyediaan air bersih. 

2. Pipa Transmisi Air Baku dari Bronkaptering ke Bak Pelepas Tekan (BPT) 

Pipa transmisi air bersih dari bronkaptering ke Bak Pelepas Tekan (BPT) 

menggunakan pipa jenis HDPE, karena pipa ini lebih ringan, memiliki fleksibilitas 

tinggi, serta mampu menahan benturan dan tekanan. Perhitungan pipa transmisi 

dilakukan secara manual menggunakan rumus Hazen-Williams 

Sistem Pengambilan Air Baku 

A. Breincaptoreiing (Peinangkap air dari mata air) 

Pada perencanaan ini, bangunan pengambilan air baku menggunakan bronkaptering 

dengan debit mata air sebesar 4,8 liter/detik, yang terletak pada jarak ± 1,34 km dari Dusun 

Laba, pada elevasi +4,50 m. Bangunan ini berfungsi untuk menangkap dan menampung 

titik-titik mata air, kemudian dari bak penampung tersebut air dialirkan ke bangunan Bak 

Pelepas Tekan (BPT). Direncanakan dimensi bak pengambilan air adalah sebagai berikut: 

Panjang = 2 meter 

Lebar = 1,25 meter 

Tinggi = 1,25 meter  

Volume bak pengambilan air: 

V = 2 × 1,25 × 1,25 

V = 3,125 m³  

Dengan volume bak pengambilan air sebesar 3,125 m³, kapasitas tersebut sudah 

mencukupi untuk menampung air dari mata air dan selanjutnya didistribusikan ke Bak 

Pelepas Tekan (BPT). 
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Gambar 2. Tampak atas bronkapteiring 

  

 
Gambar 3. Potongan A-A bronkapteiring 

B. Reservoir  

Reservoir rencana akan dibangun di lokasi yang elevasinya paling tinggi di desa 

perencanaan, dengan elevasi +4,46 m dpl. Kapasitas reservoir untuk menyeimbangkan 

antara ketersediaan dan permintaan air direncanakan sebesar sekitar 15–20% dari 

kebutuhan hari maksimum. 

Tabeil 8. Peirhituingan voluimei reiseirvoir. 

Surplus Defisit 

(1) (2) (3) (4) (5) (6) (7) (1)

24.00-05.00 5,00 4,17 2,37 20,85 12 8,98 -

05.00-06.00 1 4,17 11,87 4,17 12 - 7,700

06.00-07.00 1 4,17 11,87 4,17 12 - 7,700

07.00-09.00 2 4,17 5,93 8,34 12 - 3,5

09.00-10.00 1 4,17 11,87 4,17 12 - 7,7

10.00-13.00 3 4,17 3,96 12,51 12 0,64 -

13.00-17.00 4 4,17 2,97 16,68 12 4,81 -

17.00-18.00 1 4,17 11,87 4,17 12 - 7,7

18.00-20.00 2 4,17 5,93 8,34 12 - 3,5

20.00-21.00 1 4,17 11,87 4,17 12 - 7,7

21.00-22.00 1 4,17 11,87 4,17 12 - 7,7

22.00-24.00 2 4,17 5,93 8,34 12 - 3,5

Jumlah 92,36 91,74 130,54 14,44 53,20

Volume air di reservoir (m3)
Waktu

Jumlah 

jam 

Suppply air 

Per jam %

Pemakaian Per 

jam %

Total 

Supply%

Toal  

pemakaian 

%

 
(Suimbeir : Hasil peirhituingan 2026). 
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Uintuik meinghituing voluimei reiseirvoir, maka diguinakan nilai raa-rata dari 

juimlah preiseintasi di atas kareina peirbeidaan antara keiduia juimlah teirseibuit 

seibeinarnya hanya uintuik meinghituing kapasitas reiseirvoir dan peirbeidaan antara 

keiduia juimlah teirseibuit seibeinarnya hanya meiruipakan peimbuilatan, deingan 

deimikian maka dipeiroleih harga rata-rata kapasitas reiseirvoir adalah seibeisar : 

𝑍 =
14,44+53,20

2
  

    =  33,82 

Peirleingkapan reiseirvoir : 

a. Pipa Inleit 

Pipa inleit teirdapat 2 buiah deingan jeinis pipa Galvanis, beirdiameiteir 100 mm, dan 

inleit dileitakaan seijajar leiveil air, yaitui 20 cm dari dasar lantai reiseirvoir. 

b. Pipa ouitleit 

Pipa ouitleit teirdapat 2 buiah , dileitakan 20 cm di atas dasar lantai reiseirvoir. 

c. Peinguiras 

Pipa peinguiras meimiliki diameiteir 50 mm, dileitakan 15 cm dari dasar lantai 

reiseirvoir. 

d. Pipa Veintilasi 

Pipa veintilasi meimiliki diameiteir 50 mm. Reiseirvoir beirbeintuik seigi panjang, 

deingan kapasitas 17,650 m³. Reiseirvoir ini akan mngalirkan air kei peirpipaan yang 

ada dalam peireincanaan.         

Desain pipa transmisi dari bronkaptering ke bak pelepas tekan 

Dalam sistem perencanaan ini, jenis pipa yang digunakan pada sistem transmisi 

sampai distribusi adalah pipa HDPE. Transmisi direncanakan dari bronkaptering ke Bak 

Pelepas Tekan (BPT). 

Diketahui: 

h₁ = 886 m (elevasi muka air di dalam bronkaptering) 

h₂ = 790 m (elevasi ujung pipa keluaran air di BPT) 

Sehingga: 

H = 886 m – 790 m 

H = 96 m 

Diameter pipa: 

D = 2,5 inch = 0,0635 m 

Panjang pipa berdasarkan peta: 

L = 1030 m + (1030 m × 20%) 

L = 1236 m 

Jumlah pipa: 

1236 m ÷ 4 m (1 batang) = 309 batang pipa 

(Penambahan 20% panjang pipa dilakukan karena jalur pipa melewati hutan dan 

jalan yang berbelok-belok, sehingga panjang aktual lebih besar dari panjang pada peta). 

Koefisien Hazen-Williams (Cₕw) = 140 

Mengalami kehilangan head: 

h₁ = 886 m (elevasi muka air di dalam intake) 

h₂ = 790 m (elevasi ujung pipa keluaran air di BPT) 

h = 886 m – 790 m 

h = 96 m 

Debit: 

Q = 4,8 liter/detik = 0,0048 m³/detik 

Diameter: 
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D = 0,0635 m 

Nilai kehilangan head yang tersedia: 

h = 96 m (memenuhi/ok) 

Menghitung kecepatan aliran menggunakan persamaan Hazen-Williams: 

V = 0,3545 Cₕw D⁰·⁶³ S⁰·⁵⁴ 

Sistem Jaringan Pipa Menggunakan EPANET 2.0 

Untuk perhitungan jaringan distribusi air bersih menggunakan software EPANET 

2.0. Hasil analisis perhitungan sistem jaringan pipa di Dusun Laba Desa Rosoan 

menunjukkan bahwa letak reservoir yang berada lebih tinggi dari daerah pelayanan 

dimanfaatkan untuk pengaliran air menggunakan sistem gravitasi. 

Untuk memudahkan proses pengaliran air, terdapat beberapa hal yang harus 

dilakukan, di antaranya adalah: 

A. Jumlah Node yang Direncanakan 

Node adalah titik percabangan atau pertemuan dalam jaringan distribusi. Jumlah 

node disesuaikan dengan jalur pipa yang direncanakan serta letak rumah-rumah warga di 

Dusun Laba Desa Rosoan. 

Berikut adalah tabel yang menjelaskan beberapa node dalam perencanaan, beserta 

elevasi setiap titik node dan kebutuhan debit air pada masing-masing node pelayanan. 

Tabeil 9 Jumlah  node dan pelayanan setiap node 
Node Elevasi kebutuhan  node/detik

1 437 0.3 

2 422 0.2 

3 423 0.2 

4 421 0.3

5 421 0.3

6 421 0.2

7 419 0.2

8 418 0.2

9 405 0.3

10 409 0.3

11 406 0.2

12 401 0.2

13 390 0.2

14 388 0.3

15 393 0.3

16 384 0.2

17 378 0.2

18 361 0.2

19 384 0.1

20 359 0.2

21 349 0.2

22 339 0.2

23 363 0.2

24 336 0.1

25 413 0.1

Reservoir 4.46 #N/A  
(Suimbeir : Hasil  peirhituingan, 2026) 

  

B. Data Yang diinput ke Epanet 

Tabel 10. Data koordinat x,y dan elevasi. 

Nodei Koordinat x Koordinat y Eileivasi 

1 812561 9,613,032 437.0 

2 812429 9,613,077 422.0 
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3 812420 9,613,094 423.0 

4 812395 9,613,104 421.0 

5 812384 9,613,100 421.0 

6 812391 9,613,078 421.0 

7 812375 9,613,078 419.0 

8 812365 9,613,097 418.0 

9 812332 9,613,056 405.0 

10 812325 9,613,113 409.0 

11 812340 9,613,151 406.0 

12 812368 9,613,167 401.0 

13 812305 9,613,118 390.0 

14 812270 9,613,056 388.0 

15 812261 9,613,054 393.0 

16 812261 9,613,109 384.0 

17 812228 9,613,103 378.0 

18 812247 9,613,032 361.0 

19 812210 9,613,005 384.0 

20 812101 9,613,005 359.0 

21 812086 9,613,007 349.0 

22. 812061 9,612,993 339.0 

23. 812005 9,613,091 363.0 

24. 811950 9,613,097 336.0 

25. 812373 9,613,128 413.0 

Reiseirvoir  812662 9,613,035 4.46.0 

(Suimbeir : Hasil peirhituingan 2026) 

Proses Input Data 

1. Buka software EPANET. 

2. Lakukan setting Auto-Length dalam posisi ON (Menu: Project → Defaults → 

Properties). 

3. Lakukan pengaturan satuan yang dikehendaki (Menu: Project → Defaults → 

Hydraulics). 

4. Input data melalui File → Import → Network. Pilih file .inp pada folder tempat 

menyimpan hasil generate sebelumnya. 

5. Node dengan koordinat dan elevasi seperti pada Google Earth akan tergambar di 

layar EPANET. 

6. Node hasil import data dihubungkan dengan pipa sesuai peta jaringan pipa yang 

direncanakan. 

7. Tambahkan reservoir di lokasi sumber/asal air. 

8. Tambahkan pompa, apabila ada dalam perencanaan. 

9. Masukkan data kebutuhan pelayanan (debit) dan elevasi pada setiap node/titik 

tapping. 

10. Masukkan data diameter dan koefisien kekasaran pipa. 

11. Hubungkan Node 1 ke Node 2 dan seterusnya sesuai jalur jaringan. 

12. Gambar jaringan sesuai dengan perencanaan yang telah dibuat 
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Gambar 4. Skema sistem perencanaan air bersih mengguinakan Epanet 2.0 

 

Tabel 11. Link parameter jaringan air bersih di Dusun Laba Desa Rosoan 

Nodei  Diameiteir Rouighneiss 

1 101.6 140 

2 63.5 140 

3 63.5 140 

4 25.4 140 

5 25.4 140 

6 63.5 140 

7 38.1 140 

8 25.4 140 

9 25.4 140 

10 25.4 140 

11 38.1 140 

12 38.1 140 

13 38.1 140 

14 38.1 140 

15 38.1 140 

16 38.1 140 

17 38.1 140 

18 38.1 140 

19 25.4 140 

20 25.4 140 

21 25.4 140 

22 25.4 140 

23 38.1 140 

24 38.1. 140 

25 25.4 140 

(Suimbeir : Hasil peirhituingan 2026) 
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KESIMPULAN  

Berdasarkan hasil penelitian yang meliputi pengumpulan data serta analisis data, 

maka dapat disimpulkan sebagai berikut: 

1. Proyeksi jumlah penduduk Desa Rosoan untuk 5 tahun ke depan (tahun 2030) adalah 

318 jiwa, dengan kebutuhan total air bersih pada tahun 2030 sebesar 0,267 liter/detik. 

2. Untuk menangkap air dari mata air, digunakan bronkaptering dengan ukuran 2 m × 

1,25 m × 1,25 m. Air kemudian dialirkan secara gravitasi ke reservoir yang berukuran 

5 m × 4 m × 4,5 m. Untuk mengalirkan air dari bronkaptering ke reservoir digunakan 

pipa transmisi HDPE 2,5 inch. Kapasitas volume reservoir sebesar 41,039 m³. Setelah 

air mencapai reservoir, air tersebut dialirkan ke pipa induk dan selanjutnya ke pipa 

pembagi untuk didistribusikan kepada masyarakat.. 

Saran 

Berdasarkan pengujian dan hasil yang diperoleh, terdapat beberapa hal yang masih 

perlu untuk dikembangkan, sehingga penulis memberikan beberapa saran untuk penelitian 

berikut: 

1. Perlu dilakukan pemeliharaan terhadap daerah sekitar mata air agar di masa yang akan 

datang debit mata air tidak mengalami penurunan. Selain itu, perlu dibentuk lembaga 

pengelola sistem penyediaan air bersih serta memberikan pelatihan manajemen dan 

teknik operasi serta pemeliharaan instalasi kepada para pengurusnya. 

2. Kepada pemerintah, diharapkan dapat memberikan sosialisasi atau penyuluhan 

mengenai pentingnya penggunaan air bersih dalam kehidupan sehari-hari secara 

merata sesuai dengan kebutuhan masyarakat. Selain itu, pemerintah diharapkan dapat 

membantu pihak PDAM Kabupaten Enrekang berupa penyediaan sarana dan 

prasarana untuk mendukung peningkatan kapasitas produksi air dari sumber-sumber 

baku maupun sumber potensial lainnya. 

3. Masyarakat perlu menumbuhkan kesadaran akan pentingnya penggunaan air bersih 

dalam setiap proses pemenuhan kebutuhan sehari-hari, serta berperan aktif dalam 

mendukung program penyediaan air bersih dan menerima teknologi baru yang 

berkaitan dengan peningkatan kualitas dan kapasitas air bersih. 
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